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using this
manual

This user manual has been specially

designed to guide you through the functions and
features of your mobile phone. To get started quickly,
refer to “introducing your mobile phone,”
‘assembling and preparing your mobile phone,”

and “using basic functions.”

Instructional icons

Before you start, familiarise yourself with the icons
you will see in this manual:

Warning —situations that could cause
wamne  injury to yourself or others

& Caution—situations that could cause

o=, damage to your phone or other equipment

@ Note—notes, usage tips, or additional
information

| 2 Refer to—pages with related information;
for example: » p. 12 (represents “see page
127)



—> Followed by—the order of options or
menus you must select to perform a step;
for example: In Idle mode, select
Messages —> Create message (represents
Messages, followed by Create message)

[ 1 Square brackets—phone keys; for
example: [*@™] (represents the Power/
Menu exit key)

Copyright information

Rights to all technologies and products that
comprise this device are the property of their
respective owners:

* Bluetooth® is a registered trademark of the
Bluetooth SIG, Inc. worldwide.
Bluetooth QD ID: BO16189

Java™ is a trademark of Sun Microsystems, Inc.

Windows Media Player® is a registered trademark
of Microsoﬁ Corporaﬁon

\nc CS Headphone and WOW HD techno\og\es
are incorporated under licence from SRS Labs,
Inc.

Wi-Fi®, the Wi-Fi CERTIFIED logo, and the Wi-Fi logo
are registered trademarks of the Wi-Fi Alliance.
DivX® is a registered trademark of
DivX; Inc., and is used under
licence.

Sdna C€01680
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ABOUT DIVX VIDEO

DivX® is a digital video format created by DivX, Inc.
This is an official DivX Certified device that plays DivX
video. Plays DivX® video up to 320x240.

ABOUT DIVX VIDEO-ON-DEMAND

This DivX® Certified device must be registered with
DivXin order to play DivX Video-on-Demand (VOD)
content. First generate the DivX VOD registration
code for your device and submit it during the
registration process. [[mportant: DivX VOD content is
protected by a DivX DRM (Digital Rights
Management) system that restricts playback to
registered DivX Certified devices. If you try to play
DivX VOD content not authorised for your device, the
message "Authorization Error" will be displayed and
your content will not play.] Learn more at
http://vod.divx.com.

E

—Z

2

\\
)

N
NN

|\

=
E K
=
=




contents

safety and usage information .................. 2

Safety warnings .......c.ccceveeennen. 2
Safety precautions .............. .l
Important usage information ....................... 7
introducing your mobile phone ............. 12
UNPACK ettt 12

assembling and preparing your

feleil® [EEMB cocmmenocmnerosnoomosnooeenooon: 17
Install the SIM or USIM card and battery ...17
Charge the battery .......cccocevveviiieiiiinns

Insert a memory card (optional) .. .
Attach a hand strap (optional) ...................




SJUBILI0D

using basic functions .........ccccceeeiiiieeeens 23

Vi

Turn your phone on and off .......ccccccveenen. 23
Use the touch screen .........ccoccvvviviviicnnne, 24
Access menus ..........
Switch applications ..
Access an appllcatlon using the Gate key 26
Access an application by snapping

the PhONE ...vvvviiicccec
Use widgets .................
Access help information ..
Customise your phone ....
Use basic call functions

Send and view Messages ..........c.cocerrnine 35
Add and find contacts .........cccceveeiiieeiinns 8
Use basic camera functions ...........c.cc.c..... 38
Listen to music %0

Browse the web ..o 42
Use the Google SENViCes ........ccocvvvvvriveiunnns 43

using advanced functions ..........cccceen... 45
Use advanced call functions ..........cccccee.e 45
Use advanced phonebook functions ......... 48

Use advanced messaging functions ..
Use advanced camera functions ...
Use advanced music functions .................

using tools and applications .................

Use the Bluetooth wireless feature
Activate and connect to a wireless LAN

(WLAN) oo 62
Share media files with other devices ......... 63
Activate and send an SOS message ......... 64

Activate the mobile tracker ..............c.cceen.
View the phone display on a TV
Make fake calls ......cccveeiiiiieieiiiiee e
Record and play voice memos
Edit images ....coovvveiiiiiiiiiiieciiec e
Print images ........cccooviiiiiii,




Edit VIJEOS oo 70

Upload photos and videos to the web ....... 72
Use Java-powered games and

APPNICAtIONS .vvviviieeiie e 78
Synchronise data ..........cccceevviiiiiiiiiiennnn, 74
Use RSS feedS ..ooovvviviiiiiieiiciiciiciecne 76
Launch the Samsung Mobile Navigator ..... 76
View your current position ...........cc.cceeeevens 77

Update the GPS functionality .
Create and view world clocks ...

Set and use alarms ............ .78
Use the calculator .........cccoeveviviiiiiniiennne. 79
Convert currencies or measurements ........ 79
Set a countdown timer ...........cceeve ...80
Use the stopwatch . ...80
Create new tasks ...... ...80
Create text MemOS ....ccevvvvveviveiiiiiiieeie, 80
Create SketChes .......ccvvveviveiiiiciieciieene, 80
Manage your calendar .........ccccoocveiiiennnnn 82

vii

SJUBILI0D



safety ana
usage
iNformation

Comply with the following precautions to avoid
dangerous or illegal situations and ensure peak
performance of your mobile phone.

& Safety warnings

'WARNING

Keep your phone away from small
children and pets

Keep your phone and all accessories out of the
reach of small children or animals. Small parts may
cause choking or serious injury if swallowed.

Protect your hearing

Listening to a headset at high volumes can
damage your hearing. Use only the
minimum volume setting necessary to hear

your conversation or music.



Install mobile phones and equipment
with caution

Ensure that any mobile phones or related equipment
installed in your vehicle are securely mounted. Avoid
placing your phone and accessories near or in an air
bag deployment area. Improperly installed wireless
equipment can cause serious injury when air bags
inflate rapidly.

Handle and dispose of batteries and
chargers with care

e Use only Samsung-approved batteries and
chargers specifically designed for your phone.
Incompatible batteries and chargers can cause
serious injuries or damage to your phone.

e Never dispose of batteries or phones in a fire.
Follow all local regulations when disposing used
batteries or phones.

e Never place batteries or phones on or in heating
devices, such as microwave ovens, stoves, or
radiators. Batteries may explode when
overheated.

e Never crush or puncture the battery. Avoid
exposing the battery to high external pressure,
which can lead to an internal short circuit and
overheating.

Avoid interference with pacemakers

Maintain a minimum of 15 cm (6 inches) between
mobile phones and pacemakers to avoid potential
interference, as recommended by manufacturers
and the independent research group, Wireless
Technology Research. If you have any reason to
suspect that your phone is interfering with a
pacemaker or other medical device, turn off the
phone immediately and contact the manufacturer of
the pacemaker or medical device for guidance.
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Turn off the phone in potentially
explosive environments

Do not use your phone at refuelling points (service
stations) or near fuels or chemicals. Tumn off your
phone whenever directed by waming signs or
instructions. Your phone could cause explosions or
fire in and around fuel or chemical storage and
transfer areas or blasting areas. Do not store or carry
flammable liquids, gases, or explosive materials in
the same compartment as the phone, its parts, or
accessories.

Reduce the risk of repetitive motion
injuries

While using your phone, hold the phone with a
relaxed grip, press the keys lightly, use special
features that reduce the number of keys you have to
press (such as templates and predictive text), and
take frequent breaks.
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Do not use the phone if the screen is
cracked or broken

Broken glass or acrylic could cause injury to your
hand and face. Bring the phone to a Samsung
service centre to replace the screen. Damage
caused by careless handling will void your
manufacturer's warranty.

& Safety precautions

CAUTION

Drive safely at all times

Avoid using your phone while driving and obey all
regulations that restrict the use of mobile phones
while driving. Use hands-free accessories to
increase your safety when possible.



Follow all safety warnings and
regulations

Comply with any regulations that restrict the use of a
mobile phone in a certain area.

Use only Samsung-approved
accessories

Using incompatible accessories may damage your
phone or cause injury.

Turn off the phone near medical
equipment

Your phone can interfere with medical equipment in
hospitals or health care facilities. Follow all
regulations, posted warnings, and directions from
medical personnel.

Turn off the phone or disable the
wireless functions when in an aircraft
Your phone can cause interference with aircraft
equipment. Follow all airline regulations and turn off
your phone or switch to a mode that disables the
wireless functions when directed by airline
personnel.

Protect batteries and chargers from
damage

* Avoid exposing batteries to very cold or very hot
temperatures (below 0° C/32° F or above 45° C/
113° F). Extreme temperatures can reduce the
charging capacity and life of your batteries.
Prevent batteries from contacting metal objects,
as this can create a connection between the +
and - terminals of your batteries and lead to
temporary or permanent battery damage.

e Never use a damaged charger or battery.
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Handle your phone carefully and
sensibly

Do not disassemble your phone due to a risk of
electric shock.

Do not allow your phone to get wet—liquids can
cause serious damage and will change the colour
of the label that indicates water damage inside the
phone. Do not handle your phone with wet
hands. Water damage to your phone can void
your manufacturer's warranty.

Avoid using or storing your phone in dusty, dirty
areas to prevent damage to moving parts.

Your phone is a complex electronic device—
protect it from impacts and rough handling to
avoid serious damage.

Do not paint your phone, as paint can clog
moving parts and prevent proper operation.

If your phone has a camera flash or light, avoid
using it close to the eyes of children or animals.

e Your phone may be damaged by exposure to
magnetic fields. Do not use carrying cases or
accessories with magnetic closures or allow your
phone to come in contact with magnetic fields for
extended periods of time.

Avoid interference with other electronic
devices

Your phone emits radio frequency (RF) signals that
may interfere with unshielded or improperly shielded
electronic equipment, such as pacemakers, hearing
aids, medical devices, and other electronic devices
in homes or vehicles. Consult the manufacturers of
your electronic devices to solve any interference
problems you experience.



Important usage information

Use your phone in the normal position
Avoid contact with your phone’s internal antenna.

Allow only qualified personnel to service
your phone

Allowing unqualified personnel to service your phone
may result in damage to your phone and will void
your warranty.

Ensure maximum battery and charger

life

* Avoid charging batteries for more than a week, as
overcharging may shorten battery life.

e Over time, unused batteries will discharge and
must be recharged before use.

e Disconnect chargers from power sources when
not in use.

e Use batteries only for their intended purpose.

Handle SIM cards and memory cards

with care

e Do not remove a card while the phone is
transferring or accessing information, as this
could result in loss of data and/or damage to the
card or phone.

e Protect cards from strong shocks, static

electricity, and electrical noise from other devices.

® Frequent writing and erasing will shorten the life
span of memory cards.

¢ Do not touch gold-coloured contacts or terminals
with your fingers or metal objects. If dirty, wipe the
card with a soft cloth.
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Ensure access to emergency services

Emergency calls from your phone may not be
possible in some areas or circumstances. Before
travelling in remote or undeveloped areas, plan an
alternate method of contacting emergency services
personnel.

Specific Absorption Rate (SAR)
certification information

Your phone conforms to European Union (EU)
standards that limit human exposure to radio
frequency (RF) energy emitted by radio and
telecommunications equipment. These standards
prevent the sale of mobile phones that exceed a
maximum exposure level (known as the Specific
Absorption Rate, or SAR) of 2.0 watts per kilogram.

During testing, the maximum SAR recorded for this
model was 0.58 watts per kilogram. In normal use,
the actual SAR is likely to be much lower, as the
phone has been designed to emit only the RF
energy necessary to transmit a signal to the nearest
base station. By automatically emitting lower levels
when possible, your phone reduces your overall
exposure to RF energy.

The Declaration of Conformity at the back of this
manual demonstrates your phone’s compliance with
the European Radio & Terminal Telecommunications
Equipment (R&TTE) directive. For more information
about the SAR and related EU standards, visit the
Samsung mobile phone website.



Correct disposal of this product
(Waste Electrical & Electronic Equipment)

(Applicable in the European Union and
other European countries with separate
collection systems)

mmmm his marking on the product, accessories

or literature indicates that the product and
its electronic accessories (e.g. charger, headset,
USB cable) should not be disposed of with other
household waste at the end of their working life. To
prevent possible harm to the environment or human
health from uncontrolled waste disposal, please
separate these items from other types of waste and
recycle them responsibly to promote the sustainable
reuse of material resources.

Household users should contact either the retailer
where they purchased this product, or their local
government office, for details of where and how they
can take these items for environmentally safe
recycling.

Business users should contact their supplier and
check the terms and conditions of the purchase
contract. This product and its electronic accessories
should not be mixed with other commercial wastes
for disposal.

This EEE is compliant with RoHS.
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Correct disposal of batteries in this
product

(Applicable in the European Union and
other European countries with separate
pattery retumn systems)

This marking on the battery, manual or
packaging indicates that the batteries in this product
should not be disposed of with other household
waste at the end of their working life.

Where marked, the chemical symbols Hg, Cd or Pb
indicate that the battery contains mercury, cadmium
or lead above the reference levels in EC Directive
2006/66. If batteries are not properly disposed of,
these substances can cause harm to human health
or the environment.

10

To protect natural resources and to promote material
reuse, please separate batteries from other types of
waste and recycle them through your local, free
battery retumn system.

Disclaimer

Some content and services accessible through this
device belong to third parties and are protected by
copyright, patent, trademark and/or other intellectual
property laws. Such content and services are
provided solely for your personal noncommercial
use. You may not use any content or services in a
manner that has not been authorised by the content
owner or service provider. Without limiting the
foregoing, unless expressly authorised by the
applicable content owner or service provider, you
may not modify, copy, republish, upload, post,
transmit, translate, sell, create derivative works,
exploit, or distribute in any manner or medium any
content or services displayed through this device.



‘THIRD PARTY CONTENT AND SERVICES ARE
PROVIDED "AS IS." SAMSUNG DOES NOT
WARRANT CONTENT OR SERVICES SO
PROVIDED, EITHER EXPRESSLY OR IMPLIEDLY,
FOR ANY PURPOSE. SAMSUNG EXPRESSLY
DISCLAIMS ANY IMPLIED WARRANTIES,
INCLUDING BUT NOT LIMITED TO, WARRANTIES
OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. SAMSUNG DOES NOT
GUARANTEE THE ACCURACY, VALIDITY,
TIMELINESS, LEGALITY, OR COMPLETENESS OF
ANY CONTENT OR SERVICE MADE AVAILABLE
THROUGH THIS DEVICE AND UNDER NO
CIRCUMSTANCES, INCLUDING NEGLIGENCE,
SHALL SAMSUNG BE LIABLE, WHETHER IN
CONTRACT OR TORT, FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL OR
CONSEQUENTIAL DAMAGES, ATTORNEY FEES,
EXPENSES, OR ANY OTHER DAMAGES ARISING
OUT OF, OR IN CONNECTION WITH, ANY
INFORMATION CONTAINED IN, OR AS A RESULT

OF THE USE OF ANY CONTENT OR SERVICE BY
YOU OR ANY THIRD PARTY, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES."

Third party services may be terminated or interrupted
at any time, and Samsung makes no representation
or warranty that any content or service will remain
available for any period of time. Content and
services are transmitted by third parties by means of
networks and transmission facilities over which
Samsung has no control. Without limiting the
generality of this disclaimer, Samsung expressly
disclaims any responsibility or liability for any
interruption or suspension of any content or service
made available through this device.

Samsung is neither responsible nor liable for
customer service related to the content and
services. Any question or request for service relating
to the content or services should be made directly to
the respective content and service providers.

11
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iNtroducing your
mobile phone

In this section, leam about your mobile phone’s
layout, keys, and icons.

12

Unpack

Check your product box for the following items:

e Mobile phone

e Battery

e Travel adapter (charger)

e User manual

'g gge items supplied with your phone may vary

pending on the software and accessories

available in your region or offered by your
service provider. You can obtain additional
accessories from your local Samsung dealer.



Phone layout

The front of your phone includes the following keys
and features:

Earpiece %/% \_ Front camera

lens for video
calls

— 71— louch screen
Volume key—e

Menu ke

W— Power/Menu
Dial key_| (\% exit key

Mouthpiece———*

The rear of your phone includes the following keys

and features:

Multifunction —=~__Headset/
jack ?{@ TV-out cable jack
Rear camera ﬁ@ | ashoub

lens = 12

Hold key —e

-— 1

Gate key —;

— Battery cover

Camera key — J

w
*~—— Internal antenna

',, You can lock the touch screen and keys to
J prevent any unwanted phone operations. To

lock, press the Hold key.

13
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Keys

Key

- (=) D

Menu

suoyd sjigow JnoA Bupnpoaul

Function

Meake or answer a call; InIdle mode,
retrieve recently dialled, missed, or
received numbers

Key

Hold

Function

Lock or unlock the touch screen and
keys

Access Menu mode; Shows all active
applications (press and hold)

[] Cate

Open the cube screen to access
entertainment applications; Access
the motion tutorial and motion-
activated shortcuts (press and hold)

Tum the phone on and off (press and

[i) Camera

In Idle mode, tum on the camera; In
Camera mode, take a photo or record
avideo

Power/ hold); End a call; In Menu mode,
Menu exit  retum to the main menu or retum to
Idle mode
o ‘ ,
[] Volume Adjust the phone's volume

0
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Icons
Learn about the icons that appear on your display.

Icon Definition

Signal strength

GPRS network connected

EDGE network connected

UMTS network connected

HSDPA network connected

\oice call in progress

Video callin progress

SOS message feature activated

&
&3 Browsing the web

Icon Definition

Connected to secured web page

Roaming (outside of normal service area)

Call diverting activated

|0 B

Synchronised with PC

Bluetooth hands-free car kit or headset
connected

Bluetooth activated

Alam activated

Memory card inserted

New text message (SMS)

AwBE 08 2 §

New multimedia message (MMS)

15
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Definition

Icon

New emall message

bg

New voice mail message

Nomal profile activated

q
N

\\\\\\\

//2?/

Silent profile activated
Battery power level
Curent time

introducing your mobile phone
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assempling and
oreparnng your
mobile phone

Get started by assembling and setting up
your mobile phone for its first use.

Install the SIM or USIM card and
battery

When you subscribe to a cellular service, you will
receive a Subscriber Identity Module, or SIM card,
with subscription details, such as your personal
identification number (PIN) and optional services.

To use UMTS or HSDPA services, you can purchase
a Universal Subscriber Identity Module (USIM) card.

17



To install the SIM or USIM card and battery, 2. Insert the SIM or USIM card.
1. Remove the battery cover.

® Place the SIM or USIM card in the phone
with the gold-coloured contacts facing
down.

¢ Without inserting a SIM or USIM card, you
can use your phone’s non-network services
and some menus.

rg If the phone is on, press and hold [*g™] to tum "g
it off.

suoyd sjigqow JnoA Buuede.d pue Buquiesse .
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3.

Insert the battery.

Charge the battery

Before using the phone for the first time, you must
charge the battery.

1. Open the cover to the multifunction jack on the
top of the phone.

2. Plug the small end of the travel adapter into the
multifunction jack.

With the triangle
facing up

19
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CAUTION

Improperly connecting the travel adapter can
cause serious damage to the phone. Any
damages by misuse are not covered by the
warranty.

Plug the large end of the travel adapter into a
power outlet.

When the battery is fully charged (the icon is
no longer moving), unplug the travel adapter from
the power outlet.

Unplug the travel adapter from the phone.
Close the cover to the multifunction jack.

'Q About the low battery indicator

20

When your battery is low, the phone will emit
a warning tone and a low battery message.
The battery icon will also be empty and
blinking. If the battery level becomes too low,
the phone will automatically power off.
Recharge your battery to continue using your
phone.

Insert a memory card (optional)

To store additional multimedia files, you must insert a
memory card. Your phone accepts microSD™ or
microSDHC™ memory cards up to 16 GB
(depending on memory card manufacturer and
type).

77 Formatting the memory card on a PC may
U cause incompatibility with your phone. Format
the memory card only on the phone.

1. Remove the battery cover.
2. Unlock the memory card holder.

74
ey




3. Lift the memory card holder and insert a memory
card as shown.

("

5. Lock the memory card holder.

6. Replace the battery cover.

To remove the memory card, remove the battery
cover, unlock and lift the memory card holder, and
remove the memory card.

21
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Attach a hand strap (optional)

1.

Remove the battery cover.
2. Slide a hand strap through the slot and hook

Y ey

\
// AN
nl ﬂ sy N
=\ | 1%

it

over the small projection.
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assembiling and preparing your mobile phone
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Turn your phone on and off

US i ﬂg baSiC To tum your pnone on,

1. Press and hold [*g™].

fu n C‘ti On S 2. Enter your PIN and select Confirm (if necessary).

To turn your phone off, repeat step 1 above.

LLeam how to perform basic operations and use the Switch to the offline profile

TEI BB ES G LT O] S[anons, By switching to the offline profile, you can use your

phone’s non-network services in areas where
wireless devices are prohibited, such as aeroplanes
and hospitals.

To switch to the offline profile, in Menu mode, select
Settings — Phone profiles — Offline.

',, Follow all posted wamings and directions from
J official personnel when in areas where wireless
devices are prohibited.




Use the touch screen e Drag your finger up or down to scroll through
vertical lists.

Your phone’s touch screen lets you easily select
items or perform functions. Learn basic actions to
use the touch screen.

r,, For the optimal use of the touch screen,
d remove the screen protection film before using
your phone.

® Touch an icon to open a menu or launch an ‘
application.

e Drag your finger left or right to scroll through
horizontal lists.
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Access menus

To access your phone’s menus,

1. InIdle mode, select Menu or press the Menu
key to access Menu mode.

2. Scroll left or right to a Menu mode screen.

3. Select a menu or option.

4. Select & to move up one level; Press [75*] to

return to Idle mode.

Organise applications in Menu mode
r/, This feature may be unavailable depending on
d the software of the phone.

To change the order of icons in Menu mode,

1. InIdle mode, select Menu or press the Menu
key to access Menu mode.

2. Select (4.

3. Rotate the phone anti-clockwise to landscape
view.

4., Select an application icon and move it to the
location you want.
You can move an application icon to another
Menu mode screen.

5. Select Save.

Select Reset to initialize the order of icons in
’ Menu mode.

Use the motion sensor

Your phone features a built-in motion sensor that
switches the display from portrait to landscape
mode.

The following applications support landscape mode:
Camera, Video player, and Music player.

25
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Switch applications

Your phone allows you to multi-task by running
multiple applications at the same time.

Switch from one active application to

another

1. Press and hold the Menu key to open a list of
applications.

2. Scroll to an application and select it.
To change the view mode, select Grid view.

Close applications

To close the current application, press [*@™].

To close an application that is running in the

background,

1. Press and hold the Menu key to open a list of
applications.

2. Scroll to an application and select X.
26

Access an application using the
Gate key

To access entertainment applications,
1. Press the Gate key.

2. Select an application by rotating the cube to the
appropriate side or selecting an icon at the
bottom line of the screen.

You can launch the video player, FM radio, or
music player. You can also launch the web
browser, select a game, or access the list of
photos and videos.



Access an application by snapping
the phone

LLearn to use a motion-activated shortcut for your
favourite applications.

1. Inldle mode, press and hold the Gate key.

2. Select Guide and follow the motion tutorial. You
can learn the following actions.
e Shake the phone quickly more than 3 times to
end an application.

e Tap the top of the phone twice within 1 second to
pause or resume playback, or capture a photo.

e Snap the phone left or right and then quickly back

to the initial position to launch an application.

27
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e Quickly tilt the phone left or right and then quickly
back to the initial position to launch an
application.

’g ¢ To deactivate the motion tutorial the next time

3.
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you press and hold the Gate key, select
Deactivate.
® To access the motion tutorial, in Menu mode,

select Games and more — Motion tutorial.

When the entertainment applications screen
appears, snap the phone in the direction of the
appropriate shortcut (left or right).

4. Shake the phone more than 3 times to close the
current application.

Tips for using the motion-related actions:

e Perform the actions within 1 second.
e Wait at least 1 second before performing the
actions.
e | eamn the actions by following the motion tutorial.
'/, ® The motion-related actions are for both right
“ and left hand users.

* \When you are using multiple applications at
the same time, you cannot use the motion-
related actions.

To change an entertainment application assigned to
a motion direction,

1. In Menu mode, select Settings — Motion
settings — Motion gate.

2. Select an application to be changed.



3. Select a menu to assign to the direction and
select Save.

4. Select Save.

Use widgets

Leamn to use widgets on the widget toolbar.

’/, e Some of your widgets connect to web
J services. Selecting a web-based widget may
incur additional charges.
o Avallable widgets may vary depending on
your region or service provider.

Open the widget toolbar

In Idle mode, select the arrow at the bottom left of
the screen to open the widget toolbar. You can
rearrange widgets on the widget toolbar or move
them to the idle screen.

Move the widgets to the idle screen
1. Open the widget toolbar.

2. Drag a widget from the widget toolbar to the idle
screen. You can position the widget anywhere
on the screen.

@ To move the widgets from the idle screen to the
widget toolbar back, shake the phone with the
widget toolbar open. This feature may be
unavailable depending on the software of the
phone.

Change the widgets

1. In Menu mode, select Settings — Display and
light - Widget.

2. Select the widgets you want to include to the
widget toolbar and select Save.

29
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Use widget packages

Group your favourite widgets together as a widget

package.

To create a widget package,

1. InIdle mode, scroll left or right to one of the idle
screens.

2. Drag a widget from the widget toolbar to the idle
screen.

To open the package, scroll left or right to the
corresponding screen.

Access help information

LLearn to access helpful information about your
phone.

1. Open the widget toolbar.
2. Drag | ?|to the idle screen and select it.

30

3. Rotate the phone anti-clockwise to landscape
view.

4, Select a help topic to learn about an application
or feature.

5. Drag your finger to the right or left to get more
information. To return to the previous level, select

Customise your phone

Get more from your phone by customising it to
match your preferences.
Adjust the volume of the key tones

In Idle mode, press the Volume key up or down and
adjust the key tone volume.



Adjust the vibration intensity on the
touch screen

You can adjust the intensity of the vibration when you
touch the phone screen.

1. Inldle mode, press the Volume key up or down.

2. Select Vibration and adjust the intensity of the
vibration.

Switch to or from the silent profile
In Idle mode, select Keypad and touch and hold #
to silence or unsilence your phone.

Calibrate the screen

You can calibrate the screen so that your phone
recognises the input better.

1. In Menu mode, select Settings — Phone
settings — Calibration.

2. Touch the target on the screen.
3. Select OK.

Change your ringtone

1. In Menu mode, select Settings — Phone
profiles.

2. Select [» next to the profile you are using.

3. Select Voice call ringtone or Video call
ringtone.

4. Select a ringtone from the list and select Save.

5. Select Save.
To switch to another profile, select it from the list.
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Activate Etiquette pause

You can temporarily mute all phone sounds by
placing the phone face down when Etiquette pause
is activated.

1. In Menu mode, select Settings — Motion
settings — Etiquette pause — On.

2. Select Save.

Select a wallpaper (Idle mode)

1. Scroll left or right to one of the idle screens.

2. In Menu mode, select Settings — Display and

light - Wallpaper.

3. Scroll left or right to an image.

4. Select Set.

rg You can also set a wallpaper while viewing a
photo. If you set the photo as the wallpaper,
only the currently selected idle screen will be

changed.
32

Lock your phone
1. In Menu mode, select Settings — Security.
2. Select On under Phone lock.

3. Enter a new 4- to 8-digit password and select
Confirm.

4. Enter the new password again and select
Confirm.

',, ¢ The first ime you access a menu that
d requires a password, you will be prompted to
create and confirm a password.
e Samsung Is not responsible for any loss of
passwords or private information or other
damages caused by illegal software.



Unlock the touch screen with smart
unlock

By drawing a specified character on the locked
touch screen, you can unlock the screen only,
unlock and then make a call to a speed dial number,
or unlock and then launch an application. To set a
smart unlock character,

1. In Menu mode, select Settings — Smart
unlock.

2. Select On under Gesture unlock.
3. Select an unlock option.

4. Select a speed dial number to dial or select an
application to launch (if necessary).

5. Select a character for the smart unlock feature.
6. Select &.
7. Select Save.

Use basic call functions

LLearn to make or answer calls and use basic call
functions.

',, During a call, your phone automatically locks
d the touch screen to prevent accidental inputs.
To unlock, press the Hold key.

Make a call

1. InIdle mode, select Keypad and enter an area
code and a phone number.

2. Select = — Voice call or press [—] to dial the
number.
For a video call, select = — Video call.

3. Toend the call, press 73]
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Answer a call
1. When a call comes in, press [F].

2. Foravideo call, press [r] and select Show
me to allow the caller to see you via the front
camera lens.

3. Toendthe call, press [T*].

Adjust the volume

To adjust the volume during a call, press the Volume
key up or down.

Use the speakerphone feature

1. During a call, select Speaker — Yes to activate
the speaker.

2. To switch back to the earpiece, select Speaker.

34

You can set the phone to activate the speaker
automatically.

1. In Menu mode, select Settings — Motion
settings —> Speaker call - On.

2. Select Save.

3. During a call, place your phone on a table or a
flat surface.

',, In noisy environments, you may have difficulty

d hearing the calls while using the speakerphone
feature. For better audio performance, use the
normal phone mode.

Use the headset

By plugging the supplied headset into the
multifunction jack, you can make and answer calls:

e o redial the last call, press the headset button,
and then press again and hold.

e To answer a call, press the headset button.

e Toend a call, press the headset button.



Send and view messages

Learn to send and view text (SMS), multimedia
(MMS), and email messages.

Send a text or multimedia message

1. Inldle mode, select Messages — Create
message — Message.

Enter a destination number and select Done.
Select the text input field.

Enter your message text and select Done.

» Enter text

For sending as a text message, skip to step 7.
For attaching multimedia, continue with step 6.

6. Select Add media and add an item.
7. Select Send to send the message.

SUNESIN I

Select Tap to add recipient —> Enter manually.

Send an email

1.

In Idle mode, select Messages — Create
message — Email.

2. Select Tap to add recipient — Enter manually.

3. Enter an email address and select Done.

4, Select Tap to add subject, enter a subject, and
select Done.

5. Select Tap to add text, enter your email text,
and select Done.

6. Select Add files and attach a file (if necessary).

7. Select Send to send the message.

Enter text

With your phone’s touch screen, you can enter text
and create messages or notes.
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Change the text input method

When you open the text input field, the virtual keypad

appears. Select the Keypad drop-down menu and

select one of the following input methods for

entering text:

e Keypad

* Writing full sc.

® Writing box 1

e \Writing box 2

rg You can use a}wide Kgyboard when you ‘rotate
the phone anti-clockwise to landscape view
when entering text.

Enter text using the keypad
1. Change the text input method to Keypad.

2. Select the appropriate virtual key to enter text.

e To change case or use numbers or symbols,
select Abc or T9ADb.

6 e To enter text in T9 mode, select T9.

You can use the following text input modes:

ABC

Select the appropriate virtual key until the
character you want appears on the display.

9

1. Select the appropriate virtual key to enter an
entire word.

2. When the word displays correctly, select
Ll t0 insert a space. If the correct word
does not display, select an altemate word
from the list that appears.

Number

Select the appropriate virtual key to enter a
number.

Symbol

Select the appropriate virtual key to enter a
symbol.




Enter text using the writing full screen

1. Change the text input method to Writing full sc.

2. Write each character anywhere on the screen.
To change case or use numbers or symboals,
select Abc.

Enter text using the writing box 1

1. Change the text input method to Writing box 1.

2. Wirite each character in the writing area at the
bottom of the screen.
Write numbers and symbols in the ?1 column at
the bottom right of the writing area.

Enter text using the writing box 2

1. Change the text input method to Writing box 2.

2. Write each character in the writing area at the
bottom of the screen.
To change case or use numbers or symboals,
select Abc.

View text or multimedia messages
1. Inldle mode, select Messages — Inbox.
2. Select a text or multimedia message.

View an email

1. Inldle mode, select Messages — Email inbox.
Select an account.

Select Download.

Select an email or a header.

If you selected a header, select Retrieve to view
the body of the emall.

ISUNFER N

Add and find contacts

LLearn the basics of using the phonebook feature.
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Add a new contact

1.

[SUNESIN RN

In Idle mode, select Keypad and enter a phone
number.

Select = — Add to Phonebook — New.
Select Phone or SIM.

Enter contact information.

Select Save to add the contact to memory.

Find a contact

1.
2.

38

In Idle mode, select Phonebook.

Select the search field, enter the letter of the
name you want to find, and select Done.

You can also drag i to select the first letter of the
name.

Select the contact's name from the search list.

w Once you have found a contact, you can:
o call the contact by selecting
e edit the contact information by selecting Edit

Use basic camera functions

LLearn the basics to capture and view photos and
videos.

Capture photos

1. InIdle mode, press the Camera key to tumn on
the camera.

2. Rotate the phone anti-clockwise to landscape
view.

3. Aim the lens at the subject and make any
adjustments.
o To tum the flash on or off, select ®.
¢ To set the exposure value, select (4.



4. Press the Camera key to take a photo. e Touch and hold the screen and drag 4 to zoom

The photo is saved automatically. in. Select & to exit the zoom screen.

After capturing photos, select P to view photos. @ This feature may be unavailable depending on
. J the software of the phone.

View photos

Use one of the following methods to view photos. Capture videos

e In Menu mode, select My files — Images — My 1. Inldle mode, press the Camera key to tum on
photos — a photo file. the camera.

* In Menu mode, select Media browser — a photo 2. Rotate the phone anti-clockwise to landscape
file. view.

o
@.
=)
@
o
o]
@,
o
c
=
2
o
>
2]

@ With Media browser, you can rate the fles or 3+ Select (31 to switch to Recording mode.
d add tags to them to categorise. 4. Aim the lens at the subject and make any
adjustments.

While viewing the photo file, * To change the recording mode, select (m).

¢ Rotate the phone anti-clockwise to landscape e To tumn the flash on or off, select ®.
view. Tilt the phone to the left or right, photos will ¢ To set the exposure value, select (4.
scroll left or right automatically. 5. Press the Camera key to start recording.
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6. Select B or press the Camera key to stop
recording.
The video is saved automatically.

After capturing videos, select P to view videos.

View videos

Use one of the following methods to view videos.

* In Menu mode, select My files — Videos — My
video clips — a video file.

* InMenu mode, select Video player — a video
file.

* In Menu mode, select Media browser — a video
file.

Rotate the phone anti-clockwise to landscape view.

Listen to music

LLearn how to listen to music via the music player or
FM radio.

40

Listen to the FM radio
1. Plug the supplied headset into the phone.
2. In Menu mode, select FM radio.

3. Select Yes to start automatic tuning.
The radio scans and saves available stations
automatically.

',, The first time you access the FM radio, you will
’ be prompted to start automatic tuning.

4. Control the FM radio using the following icons:

Icon Function

E Set your phone to re-tune frequencies for
stations

Wy  Change the sound output

Tune a radio station; Select a saved radio

¥ gpion (touch and hold)
> Start the FM radio
() Tum off the FM radio




If you want to get information about the song you
hear, select More — Find music. » p. 59

Listen to music files

Start by transferring files to your phone or memory
card:
e Download from the wireless web. » p. 42

® Download from a PC with the optional Samsung
PC Studio. » p. 55

* Receive via Bluetooth. » p. 61
e Copy to your memory card. » p. 56

e Synchronise with Windows Media Player 11,
» p. 56

After transferring music files to your phone or
memory card,

1. In Menu mode, select Music player.
2. Select a music category — a music file.

3. Control playback using the following icons:

Icon Function

1] Pause playback

» Play or resume playback

Skip backward; Scan backward in a file
(touch and hold)

Skip forward; Scan forward in a file (touch
and hold)

Activate the 5.1 channel surround sound
system

ol
s
NORM  Change the sound effect
Y
x

Change the repeat mode

Activate Shuffle mode
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Browse the web

LLearn to access and bookmark your favourite web
pages.
77 *® You may incur additional charges for
fd accessing the web and downloading media.
¢ The interet menu may be labelled differently
depending on your service provider.
e Avallable icons may vary depending on your
region or service provider.

Browse web pages

1. In Menu mode, select Internet -~ Home to
launch your service provider's homepage.

2. Navigate web pages using the following icons:

Icon Function

4 » Move backward or forward on a web page

42

Icon Function

Q Refresh the current web page

L] Open a list of activated web pages

K2

5L Change the view mode

L Open a list of saved bookmarks
bl Adjust the brightness of the screen
?J Access a list of browser options

Bookmark your favourite web pages

1.
2. Select Add.
3.

4, Select Save.

In Menu mode, select Internet - Bookmarks.

Enter a page title and a web address (URL).



Use the Google services

LLearn how to use various Google services.

',, e This feature may be unavailable depending
d on your region or service provider.
® The steps you must select to use this feature
may differ depending on your region or
service provider.

Connect to Search

1. In Menu mode, select Google — Search.
2. Enter a keyword in the search field.

Connect to Malil

1. In Menu mode, select Google — Mail.
2. Set up your Google account and sign in.
3. Send or receive emails.

Connect to Maps

r,, The map service may be unavailable
’ depending on your region.

To search the map,

1. In Menu mode, select Google — Maps.
2. Scroll through the map.

3. Zoom in or out on the location you want.
To search for a specific location,

1. In Menu mode, select Google —~ Maps.

2. Select Menu — Search Map and enter the
address or the category of the business.

To get directions to a specific destination,
1. In Menu mode, select Google —~ Maps.
2. Select Menu — Get Directions.
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3. Enter the addresses of the starting location and
the ending location.

4, Select Show directions to view on the map.

data files.
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using basic functions




using advanceo
functions

Leam how to
ac

Use advanced call functions

LLearn about your phone'’s additional calling
capabilities.

View and dial missed calls

Your phone will display calls you have missed on the
display.

When you have one missed call, select the call from
the event alert widget and select Voice call to dial.

When you have two missed calls or more, select the
call from the event alert widget and select Logs — a
missed call.

Call a recently dialled number

1. Inldle mode, press [F] to display a list of
recent numbers.
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2. Select the number you want and select [ or
press [m] to dial.

Hold a call or retrieve a held call
Select Hold to place a call on hold or select
Retrieve to retrieve a held call.

Dial a second call

If your network supports this function, you can dial
another number during a call:

1. Select Hold to place the first call on hold.

2. Enter the second number to dial and select New
call or press [F—].

3. Select Swap to switch between the two calls.
4. Toend the call on hold, select On hold — ).
5. Toend the current call, press [7T].

46

Answer a second call

If your network supports this function, you can
answer a second incoming call:

1. Press [r] to answer the second call.
The first call is automatically placed on hold.
2. Select Swap to switch between the calls.

Make a multiparty call (conference call)

1. Call the first party you want to add to the
multiparty call.

2. While connected to the first party, call the
second party.
The first party is automatically placed on hold.

3. When connected to the second party, select
Join.

4. Repeat steps 2 and 3 to add more parties (if
necessary).

5. To end the multiparty call, press [*&™*].



Call an international number

1. Inldle mode, select Keypad and touch and hold
0 to insert the + character.

2. Enter the complete number you want to dial
(country code, area code, and phone number),
and then select £ — Voice call or press [—]
to dial.

Call a contact from the phonebook

You can call numbers directly from the phonebook
using stored contacts. » p. 38

1. InIdle mode, select Phonebook.
2. Select the contact you want.

3. Select & next to the number you want to dial —
(LB

Reject a call

To reject an incoming call, press [7&]. The caller will
hear a busy tone.

To reject calls from certain numbers automatically,
use the auto rejection. To activate the auto rejection
and set up the reject list,

1.

NO Ok N

In Menu mode, select Settings — Application
settings — Call — All calls — Auto reject.

Select On under Activation.

Select Add number.

Select the number input field.

Enter a number to reject and select Done.
Select the check box next to the number.
Select Save.
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Use advanced phonebook functions 3. Select Add.

Learn to create namecards, set favourite numbers, 4. Selecta con}act. )
and create groups of contacts. The contact is saved to the favourite number.

r,, The first 5 favourite numbers will be assigned
Create a namecard ’ to the favourite contacts ([&j) on the widget

1. Inldle mode, select Phonebook — More — My tooloar.

namecard.
Create a group of contacts

By creating groups of contacts, you can assign

group names, ringtones, caller ID photos, and

r,, You can send your namecard by attaching it to vibration type to each group or send messages and

J a message or email or transferring it via the emalils to an entire group. Start by creating a group:
Bluetooth wireless feature.

2. Enter your personal detalls.
3. Select Save.

1. Inldle mode, select Phonebook.
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Set favourite numbers 2. Select the Contacts drop-down menu and

lect G .
1. InIdle mode, select Phonebook. selectiaroups

3. Select Create group.
2. Select the Contacts drop-down menu and group
select Favourites. 4. Seta group name, the caller ID photo, a group

ringtone, and vibration type.
48 5. Select Save.




Link your photos to contacts

Learn to tag faces in your photos to make calls or
send messages from photos.

To link your photos to contacts,

1. In Menu mode, select Photo contacts.

2. Select Add — a photo.

3. Select Edit to add a tag to a person’s face.
4

. Select Add tag, move or resize the rectangle on
a face, and select Done (if necessary).

5. Select the face tag — Link to Phonebook — a
contact.
The selected contact is linked to the photo.

6. Select & to add more photo contacts (step 2).

Make calls or send messages from
photos

1.
2.

In Menu mode, select Photo contacts.
Scroll up or down to a photo.
The face tag appears with the name.

Select the face tag — Voice call, Video call, or
Message.

Use advanced messaging functions

LLeamn to create and use templates to create new
messages, and create message folders.

Create a text template

1.

In Idle mode, select Messages — Templates —
Text templates.

Select Create to open a new template window
and enter your text.

Select Save.
49
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Create a multimedia template

1. InIdle mode, select Messages — Templates —>
Multimedia templates.

2. Select Create to open a new template window.

3. Create a mulimedia message, with a subject
and desired attachments, to use as your
template. » p. 35

4, Select Save.

Insert text templates in new messages

1. To start a new message, in Idle mode, select
Messages — Create message — a message
type.

2. Select More — Insert > Text template > a
template.

50

Create a message from a multimedia
template

1. Inldle mode, select Messages —> Templates —
Multimedia templates.

2. Select the template you want.

3. Select Send.
Your template opens as a new multimedia
message.

Create a folder to manage messages
1. Inldle mode, select Messages — My folders.
2. Select Create folder.

3. Enter a new folder name and select Done.

Move messages from the Inbox to your folders to
manage them as your preferences.



Use advanced camera functions

LLearn how to capture photos in various modes and

customise camera settings.

Capture photos by using options preset

for various scenes

1. Inldle mode, press the Camera key to tumn on
the camera.

2. Rotate the phone anti-clockwise to landscape
view.

3. Select — a scene — OK.
4. Make any necessary adjustments.
5. Press the Camera key to take a photo.

Capture a series of photos

1. Inldle mode, press the Camera key to tun on
the camera.

@

Rotate the phone anti-clockwise to landscape
view.

Select [ ~ Continuous.
Make any necessary adjustments.

Press and hold the Camera key to take a series
of photos.

Capture panoramic photos

1.

o 0k

In Idle mode, press the Camera key to turn on
the camera.

Rotate the phone anti-clockwise to landscape
view.

Select [ — Panorama.

Select a direction.

Make any necessary adjustments.

Press the Camera key to take the first photo.
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7. Slowly move the phone to the direction you
selected. The phone captures the next photo
automatically.

8. Repeat step 7 to complete the panoramic photo.
9. Select [m to save the panoramic photo.

Capture photos in Smile shot mode

1. Inldle mode, press the Camera key to tum on
the camera.

2. Rotate the phone anti-clockwise to landscape
View.

3. Select [ ~ Smile shot.
4. Press the Camera key.

5. Aim the camera lens at your subject.
Your phone recognises people in an image and
detects their smiles. When the subject smiles,
the phone automatically takes a photo.

52

Capture divided photos

1.

In Idle mode, press the Camera key to turn on
the camera.

Rotate the phone anti-clockwise to landscape
view.

Select [ —~ Mosaic.

Select an image layout and press the Camera
key.

Make any necessary adjustments.

Press the Camera key to take photos for each
segment.

Capture photos with decorative frames

1.

2.

In Idle mode, press the Camera key to turm on
the camera.

Rotate the phone anti-clockwise to landscape
view.



S

Select [ — Frame.
Select a frame and press the Camera key.
Make any necessary adjustments.

Press the Camera key to take a photo with the
frame.

Capture videos in slow motion

1.

S

In Idle mode, press the Camera key to turn on
the camera.

Rotate the phone anti-clockwise to landscape
view.

Select (31 to switch to Recording mode.
Select [m — Slow motion.
Press the Camera key to start recording.

Select B or press the Camera key to stop
recording.

Use camera options
Before capturing a photo, select @ to access the

following options:

Option Function

Timer

Select the time delay

Resolution

Change the resolution option

White balance

Adjust the colour balance of the
photo

Effects Apply a special effect
ISO Adjust the sensitivity of camera
imaging sensor

Exposuremeter  Select a type of exposure metring
Focus mode Change the camera focus

‘ Reduce blur caused by vibration or
Anti-Shake movement
WDR Adjust the camera’s sensitivity to a

wide range of available light

53
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Option Function

Set the camera to capture a photo
again automatically when people
close eyes

Blink detection

Image quality Set the quality of your digital photos

Adjust contrast, saturation, and

Adjust sharpness

Before capturing a video, select @ to access the
following options:

Option Function

Timer Select the time delay

Resolution Change the resolution option

Adjust the colour balance of the

White balance video clip

Effects Apply a special effect

Option Function

Adjust the camera’s sensitivity to a

WHER wide range of available light
Video quality Adjust the quality of your video clips
Adjust Adjust contrast, saturation, and

sharpness

Customise camera settings

Before capturing a photo, select 8% — {03 to
access the following settings:

Setting Function

Guidelines Display the guidelines
Set the camera to switch to the
Review preview screen after capturing
photos
GPS Set the camera to record GPS
connection information to photos




Use advanced music functions

fhel!‘igrzgt?g;‘d to accompany the LLeam to prepare music files, create playlists, and
store radio stations.

Shutter sound

Select a memory location to store

Storage Lo . .
d new photos Copy music files via Samsung PC Studio
Before capturing a video, select {8y — €03 to access 1. In Menu mode, select Settings > Phone
the following settings: settings - PC connections ~ Samsung PC

ot e studio or Mass storage — Save.
etting sncion 2. Press [*g™] to return to Idle mode.

Guidelines Display the guidelines

3. Using an optional PC data cable, connect the

Audio recording  Tumn the audio on or off multifunction jack on your phone 1o a PC.

suonouny paouenpe Buisn

Select a memory location to store ‘ )
Storage ) h 4, Run Samsung PC Studio and copy files from the
new video dlips PC to the phone.
Refer to the Samsung PC Studio help for more
information.
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Copy music files to a memory card
1. Insert a memory card.

2. In Menu mode, select Settings — Phone
settings > PC connections —~ Mass storage
— Save.

3. Press [*g™] to retumn to Idle mode.

4. Using an optional PC data cable, connect the
multifunction jack on your phone to a PC.
When connected, a pop-up window will appear
on the PC.

5. Open the folder to view files.
6. Copy files from the PC to the memory card.

56

Synchronise your phone with Windows

Media Player

1. Insert a memory card.

2. In Menu mode, select Settings — Phone
settings — PC connections — Media player —~
Save.

3. Press [*g*] to return to Idle mode.

4., Using an optional PC data cable, connect the
multifunction jack on your phone to a PC with
Windows Media Player installed.

When connected, a pop-up window will appear
on the PC.

5. Open Windows Media Player to synchronise
music files.

6. Edit or enter your phone's name in the pop-up
window (if necessary).



7. Select and drag the music files you want to the Access the album list

sync list. 1. During playback, rotate the phone anti-clockwise
8. Start synchronisation. to landscape view.

2. Scroll to an album and select it.

3. Select a music file to play it.
Select (W) or (») to pause or resume the current

Create a playlist
1. In Menu mode, select Music player — Playlists.

2. Select Create. playback. G.
3. Enter a title for your new playlist. c . . . é
4. To assign an image to the playlist, select Tap to ustomise your music player settings S

edit and select an image or capture a new 1. In Menu mode, select Music player. 3

photo. 2. Select Settings. =

2

5. Select Save. 3. Adjust the settings to customise your music =
6. Select the new playlist. player. a
7. Solect Add - Tracks,
8. Select the files you want to include and select Background Set whether o play music in the

Add i background when you end the

. playing

music player
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Sound

offects Select the default equaliser type

Select a background image during
playback

Select music categories to display in
the music library screen

Visualisation

Music menu

4. Select Save.

Record songs from the FM radio

1. Plug the supplied headset into the phone.
2. In Menu mode, select FM radio.

3. Select (») to start the FM radio.

4. Select More — Record to start recording.
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5.

When you are finished recording, select Stop.
The music file will be saved in Radio clips (in
Menu mode, select My files - Sounds).

'g The recording feature is developed for voice

recording only. The quality of the recording will
pe much lower than digital media.

Store radio stations automatically

1.

Plug the supplied headset into the phone.

2. In Menu mode, select FM radio.
3.
4, Select Yes to confirm (if necessary).

Select More — Self-tuning.

The radio scans and saves available stations
automatically.



Find information of music

Learn to access an online music service and get
information about the songs you hear while on the
move.

1. In Menu mode, select Find music.

2. Select Find music to connect to the server.

3. When your phone is successfully registered,
select (o) to record a part of music you want to
find.

',, Some service providers may not support this
d service and the database may not have
information for all songs.
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Use the Bluetooth wireless feature

1
U Sl n ‘tOO | S an d LLearn about your phone's ability to connect to other
wireless devices for exchanging data and using
hands-free features.

app| |Ca—t|on8 Turn on the Bluetooth wireless feature

- 1. In Menu mode, select Bluetooth.
Leam how to work with

ey Al applications. 2. Select the circle in the centre to tum on the
Bluetooth wireless feature.

3. To allow other devices to locate your phone,
select Settings — On under My phone’s
visibility — a visibility option - Save — Save.
If you selected Custom, set duration that your
phone is visible.




Find and pair with other Bluetooth-
enabled devices

1. In Menu mode, select Bluetooth — Search.
2. Select and drag a device icon into the centre.

3. Enter a PIN for the Bluetooth wireless feature or
the other device's Bluetooth PIN, if it has one,
and select Done.

When the owner of the other device enters the
same PIN or accepts the connection, pairing is
complete.

77 You may not need to enter a PIN depending on
fd the device.

Send data using the Bluetooth wireless
feature

1. Select the file or item from one of your phone’s
applications that you want to send.

2. Select Send via or Send URL via — Bluetooth.

Receive data using the Bluetooth
wireless feature

1. Enter the PIN for the Bluetooth wireless feature
and select OK (if necessary).

2. Select Yes to confirm that you are wiling to
receive data from the device (if necessary).

Use Remote SIM mode

In Remote SIM mode, you can make or answer calls
only with a connected Bluetooth hands-free car kit
via the SIM or USIM card on your phone.

To activate Remote SIM mode,
1. In Menu mode, select Bluetooth — Settings.

2. Select On under Remote SIM mode — Save.

To use Remote SIM mode, start the Bluetooth
connection from a Bluetooth hands-free car kit.
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777 1he Bluetooth hands-free car kit must be @ The activated WLAN in the background will
fd authorised. To authorise, select the device and consume battery power. To preserve battery
select Authorise device. power, activate the WLAN only when needed.
Activate and connect to a wireless Search for and connect to a WLAN
LAN (WLAN) 1. In Menu mode, select Wi-Fi — Search.
) ) 2. Select a network icon - Add and add a
§- LLearn to activate and connect to a wireless LAN. connection profile.
= 77\ Your device uses non-harmonised frequency
‘é r’ and is intended for use in all European "g ’ zsgientert%/\gt ygnuév %m:gn;igfainmmgggii&
2 countries. The WLAN can be operated in the select Advanced éettings '
2 - Al .
8 U W‘TSLH ffdsm“c?” 'lzndoors, but cannot be * Wi-Fi security should be set as the selected
= Operated oUtaoors in France. network configuration and 802.1x (EAP-
%,_ Activate a WLAN TTLS, PEAP) is supported.
[}
1. In Menu mode, select Wi-Fi. 3. In Menu mode, select Internet or Communities,
2. Select the circle in the centre to activate a orinldie mode, select a web-based W'qget'
WLAN. Your phone connects to the network using the

connected WLAN profile.
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'Q To access the intemet via another method,
change the connection profile to the desired
method.

To connect to a WLAN using a WPS (Wi-Fi
Protected Setup) access point,

1. In Menu mode, select Wi-Fi — Search.

2. Select a WPS icon that has the @ icon and
select Add.

3. Select WPS push button or WPS enter PIN
depending on the AP device type.

4. Select Start and press a WPS button on the AP
device within 2 minutes.
Or, enter a PIN on the AP device and select Start
within 2 minutes.

’/, This feature may be unavailable depending on
J the software of the phone.

Share media files with other devices

Learn to use the DLNA (Digital Living Network
Alliance) service that enables you to share media
files between DLNA-enabled devices by using the
wireless LAN.

’/, This feature may be unavailable depending on
J the software of the phone.

1. In Menu mode, select Connected home.

2. Select the circle in the centre to turn on the
Connected home feature and search for the
device—the one that contains media files.

Select a connection profile (if necessary).
Select a device icon.

Select a folder.

Select media files.

S
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7. Select a player—the one that will play the media 5. Select the contacts you want and select Add.
fles. 6. Select a phone number (if necessary).
The media files start playback at the selected -
player. 7. Select OK to save the recipients.
8. Select the Once drop-down menu and select

8. Control playback using icons of your phone. e number of times fo repeat the SOS

Activate and send an SOS message message.

% 9. Select Save —~ Yes.
=8 Incaseof an emergency, you can send an SOS To send an SOS message, the touch screen and
(87 message asking for help. keys must be locked. Press the Volume key four
é rg This feat.ure may be unavai‘lable depending on fimes.
£ your region or service provider. 77 Once you send an SOS message, all phone
= fd functions will be suspended until you press the
= 1. Inldle mode, select Messages —~ SOS Hold key. If you press [7g], phone functions
= messages — Sending options. will be available, but the keys will remain

2. Select On to tum on the SOS messaging locked.

feature.

3. Select the recipient field to open the recipient list.
4. Select 8 to open your contact list.




Activate the mobile tracker

View the phone display on a TV

When someone inserts a new SIM or USIM card in
your phone, the mobile tracker feature will
automatically send the contact number to two
recipients to help you locate and recover your
phone. To activate the mobile tracker,

1.

© ®»® N ok 0N

In Menu mode, select Settings — Security
Mobile tracker.

Enter your password and select Confirm.
Select On to tum on the mobile tracker.

Select the recipient field to open the recipient list.

Enter a phone number.

Select OK to save the recipients.
Select the sender input field.
Enter the sender’'s name.

Select Save ~ Accept.

Learn to view files by connecting your phone to a TV.

1. With the TV on, connect your phone to the TV
with a TV out cable.

2. Switch the TV to the appropriate external input
mode.
If you cannot view the phone via the TV, try
changing the TV-out settings: In Menu mode,
select Settings — Phone settings — a video
encoding system under TV out.

',g

Your files may not display correctly, due to
differences in video systems or quality of the TV
display. The Bluetooth stereo headset and
zoom functions will not work in TV-out mode.

65
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Make fake calls

You can simulate fake incoming calls when you want
o get out of meetings or unwanted conversations.
You can also make it appear as if you are talking on
the phone by playing back a recorded voice.

Record a voice
1. In Menu mode, select Settings — Application

settings — Call —~ Fake call — Fake call voice.

2. Select On under Fake call voice.

3. Select Voice recording.

4. Select (¢ to start recording.

5. Speak into the microphone.

6. When you are finished speaking, select (w).
7

. Select & to set the recording as a response for
the fake call.

8. Select Save.

Make a fake call

To make a fake call, press and hold the Volume key
down in Idle mode.

To change the delay time before fake calls, in Menu
mode, select Settings — Application settings —
Call — Fake call - Fake call timer — an option —
Save.

Record and play voice memos

LLearn to operate your phone’s voice recorder.

Record a voice memo

1. In Menu mode, select Voice recorder.
2. Select (¢ to start recording.

3. Speak your memo into the microphone.
4

. When you are finished speaking, select (m).
Your memo is saved automatically.



Play a voice memo

1. In Menu mode, select My files - Sounds —
Voice clips.

2. Select afile.
3. Control the playback using the following icons:

Icon Function

() Pause playback

@ Play or resume playback

) Scan backward in a file (touch and hold)

») Scan forward in a file (touch and hold)

Edit images

Learn to edit images and apply fun effects.

Apply effects to images

1.

In Menu mode, select My files — Images > My
photos — a photo file.

Select &),
Select Edit ~ Effects — an effect option (filter,
style, warp, or partial blur).

Select a variation of the effect to apply and select
Done.

To apply a blur effect to a specific area of an
image, draw the rectangle and select Blur —
Done.

When you are finished with applying effects,
select Files — Save as.

Select a memory location (if necessary).
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7. Enter a new file name for the image and select Transform an image

Done. 1. Open an image to be edited. Refer to steps 1-2

in "Apply effects to images.”

Adjust an image
2. Select Edit — Transform — Resize, Rotate, or

1. Open an image to be edited. Refer to steps 1-2

) ; Flip.
in “Apply effects to images.” 5 RI“[) ! oo dosirad and selct
. ) ' ) . m n
2. Select Edit > Adjust — an adjustment option Dg;?ee orfip fhe Image as desired and seiec
(brightness, contrast, or colour). i : )
) : ; To resize the image, select a size > Save —
To adjust the image automatically, select Auto Done

level.

. } . 4. Save the edited image with a new file name.
3. Adjust the image as desired and select Done. Refer to steps 5-7 ir‘?“App\y offects to images.”
4. Save the edited image with a new file name.

Refer to steps 5-7 in “Apply effects to images.” Crop an image
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1. Open an image to be edited. Refer to steps 1-2
in “Apply effects to images.”

2. Select Edit — Crop.
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3. Draw the rectangle over the area you want to Add a memo by handwriting

crop and select Grop > Done. 1. Open an image to be edited. Refer to steps 1-2
4. Save the edited image with a new file name. in “Apply effects to images.”
Refer to steps 5-7 in “Apply effects to images.”

2. Select Edit > Memo on screen.
Insert a visual feature 3. Select a colour, write a memo on the screen,
) ' lect Done.
1. Open an image to be edited. Refer to steps 1-2 and selec .onet ) ) =
in “Apply effects to images.” 4. Save the edited image with a new file name. o
f BN ‘ 3
2. Select Edit — Insert — a visual feature (frame, Refer (o steps &-7 in "Apply effects to images g
image, clip art, emoticon, or text). Print i o
3. Select a visual feature, or enter text and select rint images §
Done. Learn to print your image with a USB connection or 8
4. Move or resize the visual feature or text and the Bluetooth wireless feature. 8
select Done. To print an image using a USB connection, %
5. Save the edited image with a new file name. 1. Connect the multifunction jack on your phone to
Refer to steps 5-7 in “"Apply effects to images. a compatible printer.

2. Openanimage. » p. 39
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3. Select More — Print via - USB.
4. Set print options and print the image.

To print an image using the Bluetooth wireless
feature,

1. Open animage. » p. 39
2. Select More — Print via — Bluetooth.

3. Select a Bluetooth-enabled printer and pair with

the printer. » p. 61
4. Set print options and print the image.

Edit videos

Learn to edit video files and apply visual effects.

Trim any segment
1. In Menu mode, select Video editor.

2. Select Files — Import image or Import video.

70

. Select an image or video category — an image

or video and select Add.
For an image, select the duration that the image
displays.

. Select More — Files to add more images or

videos.

. Select Edit — Trim.
. Select (») to play the video and select Start

mark at the point where you want the new video
to begin.

. Select End mark at the point where you want

the new video to end.

. Select Trim.
. When you are finished, select More — Export —

Video — Yes.
To save the project for future use, select More —
Files — Save project. The project will be saved
in Other files.



10. Enter a new file name and select Done.
11.To check the file, select Yes (if necessary).

Split videos

1.

Open images and videos to be edited. Refer to
steps 1-4 in “Trim any segment.”
Select Edit — Spilit.

Select (») to play the video and select Split
point — Split to divide the file into two clips.
Insert an image or video as desired between the
clips.

Save the edited video with a new file name. Refer
to steps 9-11 in “Trim any segment.”

Insert text

w Inserting text to a video may be unavailable
>

1.

depending on your service provider.

Open images and videos to be edited. Refer to
steps 1-4 in “Trim any segment.”

Select Edit — Insert > Text.

Select (») to play the video and select Start
mark at the point where you want the text to be
displayed.

Select End mark at the point where you want
the text to be disappeared.

5. Select Insert.

Enter text and select Done.
Move or resize the text and select Done.
To change the text colour, select Colour.
Save the edited video with a new file name. Refer
to steps 9-11 in “Trim any segment.”
71
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Add sound track

1. Open images and videos to be edited. Refer to
steps 1-4 in “Trim any segment.”

2. Select Additional audio track — Import sound.

3. Select Sounds — a sound category — a sound.

4. Save the edited video with a new file name. Refer
to steps 9-11 in “Trim any segment.”

Upload photos and videos to the
web

LLearn to post your photos and videos to photo
sharing websites and blogs.

r,, Communities may be unavailable depending
J on your region or service provider.

72

Set your favourite destination list
1. In Menu mode, select Communities.

2. Select Yes to set your favorite destination list (if
necessary).

3. Select Accept to confirm that you agree to the
general disclaimer.
r,, The first time you access Communities, you
’ will be prompted to confirm.

4. Select the destinations you want to add and
select Save.
If you selected Update lists, new destination
sites are added to the list automatically.
w To edit the favourite destination list or update the
lists, from the Communities screen, select
Settings — Preferred lists — Edit.



Upload a file

To upload photos and videos, you must have
accounts of photo sharing websites and blogs.
1. In Menu mode, select Communities.

2. Select a destination you want to post to.

3. Enter the user ID and password of the
destination.

4. Select Tap to add and select a media file.
5. Enter the post details and select Upload to
web.

r,, You can also upload media files from Camera
’ or My files, by selecting &%, or More —
Upload to web.

Use Java-powered games and
applications

Learn to use games and applications powered by
award-winning Java technology.

',, The download of java files may not be
d supported depending on the software of the
phone.

Download games or applications

1. In Menu mode, select Games and more —
More games.
Your phone connects to the website preset by
your service provider.

2. Search for a game or application and download it
to the phone.
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Play games
1. In Menu mode, select Games and more.

2. Select a game from the list and follow the on-
screen instructions.

r,, Available games may vary depending on your
J region or service provider. Game controls and
options may vary.

Launch applications

1. In Menu mode, select Games and more — an
application.

2. Select More to access a list of various options
and settings for your application.
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Synchronise data

LLearn to synchronise the contacts, calendar events,
tasks, and memos with the web server you have
specified. To synchronise the contacts, calendar
events, tasks, and emails, specify a Microsoft
Exchange server.

Synchronise data with a web server
To create a synchronisation profile,

1. In Menu mode, select Synchronise.

2. Select Add and specify profile parameters.
3. When you are finished, select Save.

To start synchronisation,

1. In Menu mode, select Synchronise.

2. Select a synchronisation profile.

3. Select Continue to start synchronisation with the
web server you have specified.



Synchronise data with a Microsoft
Exchange server

77 You may only use the Microsoft® Exchange
r’ ActiveSync® feature in this phone with a
service that is licensed by Microsoft
Corporation to use Microsoft® Exchange
ActiveSync®,

To set a Microsoft Exchange server and
synchronisation profile,

1. In Menu mode, select Exchange ActiveSync.
2. Specify Microsoft Exchange server settings.

3. Select Save.
4

. Specify an email connection profile by following
the email setup wizard.

5. When you are finished, select Save.

6. Select a synchronisation profile.
Synchronisation with the Microsoft Exchange
server you have specified starts.

',, You may incur additional charges for accessing
’ the server.

To synchronise all items,

1. In Menu mode, select Exchange ActiveSync.

2. Select Sync.

',, If you synchronise all items, you may incur
J charges for updating unnecessary items.

To synchronise emails only,
1. In Menu mode, select Exchange ActiveSync.
2. Select Email — Inbox — Sync — Email.
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Use RSS feeds

Learn to use RSS feeds to get the latest news and
information from your favourite websites.

Add an RSS feed address

1. In Menu mode, select Internet — RSS feeds.
2. Select Add.

3. Select the address input field.

4

. Enter the address of an RSS feed and select
Done.

Select OK.
6. Select =] -~ Add RSS feed.

o

76

Update and read RSS feeds

1. In Menu mode, select Internet - RSS feeds.
2. Select Update — a feed — Update — Yes.
3. Select a feed category — an updated feed.

',, The auto update feature sets the phone to

’ automatically update the RSS feeds at the
specified interval. You can activate the auto
update feature by selecting Internet —
Settings —~ RSS update.

Launch the Samsung Mobile
Navigator

In Menu mode, select Navigation.

For detalls, refer to the quick start guide of the
Samsung mobile navigator.



If this feature is not provided as default depending on
your region or service provider, you can install the
navigation application by yourself.
Visit http:/Awww.66.com/samsung and follow
onscreen instrunctions.

77 * While using the navigation application, do not
remove the inserted memory card.

e This feature may be unavailable depending
on your region or service provider.

View your current position

LLearn to determine the latitude, longitude, and
altitude of your current position using the global
navigation satellite system. You must be in outdoors
for using the satellite.

In Menu mode, select Settings —> Phone settings
— GPS settings > GPS position.

Update the GPS functionality

Learn to enhance the GPS functionality by
downloading GPS data files. You can improve the
speed and accuracy of positioning capability and
expand your navigation to areas where cellular
networks are not accessible.

1. In Menu mode, select Settings — Phone
settings —> GPS settings ~ GPS+ settings —
Download data.

2. Select Yes to connect to a server and download
GPS data files.

',, If your phone has the navigation feature, you

d can use a Bluetooth-enabled GPS device.
Change the connection type. In Menu node,
select Settings — Phone settings ~ GPS
settings ~ GPS navigation via —
Bluetooth GPS.
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Create and view world clocks

Learn to view the time in another region and set
world clocks to appear on your display.

View a world clock
1. In Menu mode, select World clock.

2. Scroll through the world map and select a time
zone you want.

Create a world clock

1. In Menu mode, select World clock.
2. Select & — Add.

3. Select a time zone.

4. To set daylight saving time, select *
5

. Select OK to create your world clock.
The world clock is set as the second clock.

6. Select Add to add more world clocks (step 3).

Add a world clock to your display

With the dual clock widget, you can view clocks with
two different time zones on your display.

After you have created a world clock,

1. In Menu mode, select World clock.

2. Select & — Set as second clock.

3. Select the world clock you want to add.
4. Select Set.

Set and use alarms

LLearn to set and control alarms for important events.

Set a new alarm

1. In Menu mode, select Alarms.
2. Select Create alarm.

3. Set alarm details.



4. Select Save.

r,, The auto power-up feature sets the phone to
J automatically turm on and sound the alarm at
the designated time if the phone is turned off.

Stop an alarm
When the alarm sounds,

e Drag the slider to Stop to stop the alarm without
snooze.

e Drag the slider to Stop to stop the alarm with
snooze or drag the slider to Snooze to silence the
alarm for the snooze period.

Deactivate an alarm

1. InMenu mode, select Alarms.

2. Select Off next to the alarm you want to
deactivate.

Use the calculator

1. In Menu mode, select Calculator.

2. Use the keys that correspond to the calculator
display to perform basic mathematical
operations.

Convert currencies or
measurements

1. In Menu mode, select Convertor —> a
conversion type.

2. Enter the currencies or measurements and units
in the appropriate fields.
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Set a countdown timer

Create new tasks

In Menu mode, select Timer.
Set the length of time to count down.
Select Start to begin the countdown.

When the timer expires, drag the slider to Stop
to stop the alert.

MW=

Use the stopwatch

In Menu mode, select Stopwatch.
Select Start to begin the stopwatch.
Select Lap to record lap times.
When you are finished, select Stop.
Select Reset to clear recorded times.

SN
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1. In Menu mode, select Task.
2. Select Create task.
3. Enter the details of the task and select Save.

Create text memos

1. In Menu mode, select Memo.
2. Select Create memo.
3. Enter your memo text and select Done.

Create sketches

Leamn to create sketches with various sketch tools.



Create a new sketch
1. In Menu mode, select Dynamic canvas.

2. From the sketch toolbar, select £ to change
the tool type. You have the following tools:

Tool Function

Add a line; You can select the line type, line
@
thickness, and colour

Add a circle or rectangle; You can select
the line thickness, line colour, and colour to
fill the figure

Enter text to insert; You can change the font
il size, attribute, and text colour

& Insertastamp or an image stamp

3. Using the tools, make a sketch.

4. To delete text, stamps, or image stamps that you
added, select an item — More — Delete.

5. When you are finished, select File - Save as
Image.

6. Enter a new file name and select Done.

Add motion to a sketch

1. Make a sketch with stamps or image stamps.

2. To use the preset motion type, select More —
Motion — Preset — a stamp or an image stamp
— a motion type - OK.
To use a new motion type, select More —~>
Motion — Motion line — a stamp or an image
stamp. Draw a line to track and select Preview
to preview the motion. Select OK.

3. When you are finished, select File > Save as
Flash.

4. Enter a new file name and select Done.
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Manage your calendar View events

Leam to change the calendar view and create To view events of a specific date,
events. 1. In Menu mode, select Calendar.

Change the calendar view 2. Select a date on the calendar.

1. In Menu mode, select Calendar. 3. Select an event to view its details.

To view events by event types,

2. Select More — View by day or View by week.

1. In Menu mode, select Calendar.
Create events 2. Select Event list — an event type.
1. In Menu mode, select Calendar. 3. Select an event to view its details.

2. Select Create — an event type.
3. Enter the details of the event as required.
4. Select Save.
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troubleshooting

If you are having trouble with your mobile phone, try these troubleshooting procedures before contacting a service

professional.

While using your phone, the following messages
may appear:

Message  Try this to solve the problem:

Insert SIM
22;%;% Ensure that the SIM or USIM card is
ek installed correctly.
services

When the phone lock feature is
Phone lock  enabled, you must enter the password

you set for the phone.

Message Try this to solve the problem:

When using the phone for the first time
or when the PIN requirement is
enabled, you must enter the PIN

PNcode ¢ ,00jied with the SIM or USIM card.
You can disable this feature by using
the PIN lock menu.

When you access a menu requiring

PIN2 lock the PIN2, you must enter the PIN2

supplied by the SIM or USIM card. For
details, contact your service provider.




Message Try this to solve the problem: * [Ensure that you have accessed the right cellular

Your SIM or USIM card is blocked, network. |
usually as a result of entering your PIN * Ensure that you have not set call barring for the

PUK code  incorrectly several times. You must phone number.

enter the PUK supplied by your Another caller cannot reach you.
service provider.

e Ensure that your phone is tumed on.

Your phone displays “Service unavailable” or ® Ensure that you have accessed the right cellular
“Network error.” network.
§ * \When you are in areas with weak signals or poor e Ensure that you have not set call barring for the
o reception, you may lose reception. Move to phone number.
2] N
§ another area and try again. ) ) Another caller cannot hear you speaking.
=4 e You cannot access some options without a . o
< subscription. Contact your service provider for * Ensure that you are not covering the built-in
more detalls. microphone.
You enter a number, but the call is not dialled. ¢ rET%s&rhe that the microphone s close to your
¢ Ensure that you have pressed the Dial key: [F], e If using a headset, ensure that it is properly
connected.




The phone beeps and the battery icon flashes.

Your battery is low. Recharge or replace the battery to
continue using the phone.

The audio quality of the call is poor.
e Ensure that you are not blocking the phone’s
internal antenna.

e \When you are in areas with weak signals or poor
reception, you may lose reception. Move to
another area and try again.

You select a contact to call, but the call is not
dialled.

e Ensure that the correct number is stored in the
contact list.

e Re-enter and save the number, if necessary.

The battery does not charge properly or
sometimes the phone turns itself off.

e The battery terminals may be dirty. Wipe both
gold-coloured contacts with a clean, soft cloth
and try charging the battery again.

o |f the battery will no longer charge completely,
dispose of the old battery properly and replace it
with a new battery.

Your phone is hot to the touch.

When you use several applications at once, your
phone requires more power and may heat up.

This is normal and should not affect your phone’s
lifespan or performance.
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alarms
creating, 78

deactivating, 79
stopping, 79

battery
charging, 19
installing, 17
low battery indicator, 20

Bluetooth
activating, 60

receiving data, 61
remote SIM mode, 61
sending data, 61

browser i
see web or media browser

calculator
see tools, calculator

calendar
see tools, calendar

calls
advanced functions, 45

answering additional calls, 46
answering, 34

basic functions, 33

dialing additional calls, 46
dialing missed calls, 45

from the phonebook, 47

international numbers, 47
making fake calls, 66
making, 33

multiparty, 46

placing on hold, 46
recently dialled, 45
rejecting, 47

retrieving held calls, 46
viewing missed, 45

clock
see world clock

Communities
see tools, mobile blog



conference calls.
see calls, multiparty

Connected home 63

contacts
adding, 38

creating groups, 48
finding, 38
linking from photos, 49

converter
see tools, convertor

countdown timer
see tools, countdown timer

display - viewing on TV 65
DLNA 63

Dynamic canvas
see tools, sketch memo

fake calls )
see calls, making fake calls

FM radio
listening to, 40
recording songs, 58
storing stations, 58

Google services 43

headset 34

images
adding memos, 69
adjusting, 68
applying effects, 67
cropping, 68
inserting visual features, 69
printing, 69
transforming, 68

internet
see web browser

Java
accessing applications, 74
downloading, 73
launching games, 74

key tones 30

lock
see phone lock

media browser 39

memo
see text or voice memos
memory card 20

messages
sending email, 35

sending multimedia, 35
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sending text, 35
viewing email, 37
viewing multimedia, 37
viewing text, 37

Microsoft Exchange
synchronisation 75

mobile tracker 65

multimedia
see messages

music finding 59

music player
creating playlists, 57
customising, 57
listening to music, 41
synchronising, 56

namecards 48

navigator 76
offline profile 23
phone lock 32
photo contacts 49
photos

advanced capturing, 51

basic capturing, 38
editing, 67
viewing, 39

radio
see FM radio

ringtone 31

RSS feeds
see tools, RSS feeds

Samsung PC Studio 55

silent profile 31
SIM card 17
SOS message 64

stopwatch
see tools, stopwatch

synchronisation
creating a profile, 74

starting, 74

task
see tools, task

templates
inserting, 50
multimedia, 50
text, 49



text

creating memos, 80
entering, 35
messages, 35

timer

see tools, countdown timer

tools

alarm, 78
calculator, 79
calendar, 82
convertor, 79
countdown timer, 80
image editor, 67
mobile blog, 72
RSS feeds, 76
sketch memo, 80

stopwatch, 80
task, 80
video editor, 70

video player 40

videos
advanced capturing, 53
basic capturing, 39
editing, 70
viewing, 40

voice memos
playing, 67
recording, 66

volume
call volume, 34

key tone volume, 30

wallpaper 32

web browser
adding bookmarks, 42

launching homepage, 42
widgets 29
Wi-Fi 62
Windows Media Player 56

world clock
creating, 78
setting dual display, 78
viewing, 78







SAMSUNG
ELECTRONICS

Piinsuncg
Declaration of Conformity (R&TTE)

We, Samsung Electronics

declare under our sole responsibility that the product

GSM WCDMA Wi-Fi Mobile Phone : S8000

to which this declaration relates, is in conformity with the following
standards and/or other normative documents.

SAFETY  EN60950-1 : 2006+A11:2009
EN 50332-1 : 2000
EN 50332-2 : 2003

SAR EN 50360 : 2001
EN 62209-1 : 2006

EMC EN 301 489-01 V1.6.1 (09-2005)

EN 301 489-07 V1.3.1 (11-2005)
EN 3801 489-17 V2.1.1 (05-2009)
EN 301 489-19 V1.2.1 (11-2002)
EN 301 489-24 V1.4.1 (09-2007)

RADIO EN 301 611 V9.0.2 (03-2003)
EN 300 328 V1.7.1 (10-2006)
EN 301 908-1V3.2.1 (05-2007)
EN 301 908-2 V3.2.1 (05-2007)

We hereby declare that [all essential radio test suites have been carried
out and that] the above named product is in conformity to all the
essential requirements of Directive 1999/5/EC.

The conformity assessment procedure referred to in Article 10 and
detailed in Annex(IV] of Directive 1999/5/EC has been followed with the
involvement of the following Notified Body(ies):

BABT, Forsyth House,
Churchfield Road,
Walton-on-Thames,
Surrey, KT12 27D, UK*
Identification mark: 0168

The technical documentation kept at :

Samsung Electronics QA Lab.

which will be made available upon request.
(Representative in the EU)

Samsung Electronics Euro QA Lab.
Blackbushe Business Park, Saxony Way,
Yateley, Hampshire, GU46 6GG, UK*
2010.12.01

(place and date of issue)

Joong-Hoon Choi / Lab Manager
(name and signature of authorised person)

* Itis not the address of Samsung Service Centre. For the address or the
phone number of Samsung Service Centre, see the warranty card or contact
the retailer where you purchased your product.



Some of the contents in this manual may differ from your phone depending on the software of the phone or your
service provider.

SAMSUNG ELECTRONICS ZZEIT™

Printed in Korea
World Wide Web Code No.:GH68-24283A
http://www.samsungmobile.com English (EU). 12/2010. Rev. 2.2
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